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Introduction to the Genesis Framework

Whether you're just starting out building your Genesis site, or you need a brush up on where the
things you need are located, it can help to review the basics of how our website framework works.

Let's jump in with a few basic questions before moving on to the nitty-gritty...

PLEASE NOTE: If your site is hosted on WordPress.com (example: mysite.wordpress.com),
you cannot install the Genesis Framework or new themes. This is a restriction on
WordPress.com-hosted sites.

1.1 What's a Framework?

A theme framework is a robust WordPress theme that acts as a platform on which your WordPress
website can be created. The Genesis Framework integrates all of the SEO, security, and
performance features needed to help you have the best site possible.

You can build your site on the Genesis Framework using the included Sample child theme (it's
easy, flexible, and powerful enough for that), or you can purchase one of our many beautiful
turnkey child theme designs to help you accomplish exactly what you want.

1.2 What's a Child Theme?

A child theme is a layer of code that sits on top of the Genesis Framework and is comprised mainly
of the design elements of your site, but can also extend and modify the functionality of the
Genesis Framework's default functions.

The Framework + Child Theme structure of site building is great because it separates the
performance issues of your site from the design issues. So, if you use a child theme, you can
design all day long without ever touching the critical, underlying code that makes Genesis sites so
powerful.

1.3 Theme Files

A Genesis child theme will generally be comprised, in part, of the following elements:
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Screenshot: An image of the design that the theme will create around your content.

Style sheet (style.css) (required): The CSS code that determines the look of the site based
on the HTML generated by Genesis and WordPress.

Functions file (functions.php) (required): Connects the child theme to the framework. Can
also be used to add, remove, and modify elements from the framework defaults.

Front Page file (front-page.php) (optional): Generally used to create a widgetized or
custom home page.

Other template files (optional).

Images (optional): Used by the Style sheet as a part of the site design.

These elements are grouped together in what's known as a child theme directory (or folder) and
can be activated like any other WordPress theme.

Introduction to Installing the Genesis Framework and a Child
Theme

Installing the Genesis Framework and a child theme follows the same process for installing any
WordPress theme, except that you're essentially installing two themes. First, you install the
Genesis Framework and then you install a child theme.

There are two ways to install the Genesis parent theme or a Genesis child theme:

Manually with an FTP client (File Transfer Protocol transfers files from one location to

another).

« Automatically through the upload feature in the WordPress dashboard.

PLEASE NOTE: The Genesis Framework must be installed prior to activating a child theme
and must remain in the /wp-content/themes/ directory (or folder) on your server. Also, the
directory (or folder) that contains the Genesis framework files must be named "genesis".
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2.1 Installing Genesis and a Child Theme from Inside
WordPress
You can install the Genesis Framework through the upload feature in the WordPress dashboard in

Six easy steps as shown below. When you're finished, you can repeat these steps to install a child
theme.

)

# Sample Site ¥ + New Howdy, Sample User [l

Help

@ Dashboard Themes Q e Newe

A Posts

07 Media

We help you find your dream home |

WELCOME-TO OUR AGENCY.

N Pages

- |

B Comments

© Genesis

» Appearance

Themes 1

Active: Atmosphere Pro Customize Agency Pro Theme AgentPress Pro Theme

AMBIANCE PRO

Customize

Widgets

Menus

Header
Background
Editor

Welcome to my Website

ks Plugins

- Users

# Tools
Settings Altitude Pro Theme Ambiance Pro Theme Author Pro Theme

© Collapse menu

1. Log in to your WordPress dashboard and go to Appearance > Themes.
2. Click the Add New button at the top of the page.

# Sample Site P 4 New

@ Dashboard Add Themes upload Theme e

A Posts

@ Featured Popular Latest  Favorites £} Feature Filter

07 Media
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3. Click the Upload Theme button at the top of the new page.

(W)

# SampleSite B 0 < New

@ Dashboard Add Themes srowse

A Posts
07 Media
[N Pages

P Comments

o Choose File | No file chosen e
® Genesis

M Appearance

4. Click the Choose File button and find the file for your theme on your computer. The file
will typically be named with the name of the theme and have an ending of .zip
(example: genesis.zip or genesis-sample.zip).

5. Click the Install Now button once you have selected the theme file for upload.

On the next screen, you will see three links:

x":" # SampleSite B 0 4 New

@ Dashboard Installing Theme from uploaded file: genesis.2.2.3.zip

A Posts Unpacking the package...
q] Media Installing the theme...

M Pages Theme installed successfully.
® Comments Live Preview | Activate | Return to Themes page

+ Live Preview: This will display your site using the newly installed theme in a preview mode
so you can see what it would look like.

+ Activate: This will apply the newly installed theme to your live site. When installing the
Genesis Framework, you don't need to activate it. Instead, you'll install and activate a child
theme.
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* Return to Themes page: This will take you to the Appearance > Themes page. Here you
can see all the installed themes as well as install the Genesis Child Theme of your choice.

@ @A sampleSite W 0 4 New

@ Dashboard Installing Theme from uploaded file: genesis.2.2.3.zip

A Posts Unpacking the package...
q] Media Installing the theme...

M Pages Theme installed successfully.

S : :
® Comments Live Preview | Activate | Return to Themes page o

6. After installing the Genesis Framework, click the Return to Themes page link to install
and activate a child Theme.

Now that you've installed the Genesis Framework, repeat steps 1 - 5 to install a child Theme.

2.2 Installing Genesis and a Child Theme Using FTP

If you prefer, you can install the Genesis Framework and a child theme manually using FTP. Some
popular FTP programs to use for this process include:

* CuteFTP
« Filezilla
* Transmit

+ Cyberduck

Before you begin, unzip the theme packages (Genesis and a child theme) to your computer's
desktop.

Now you're ready to connect to your site via FTP.
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St ﬁ | i B }i ‘wp-content

Name ¥ Name ¥
xmirpc.php » ' uploads
wp-trackback.php b || upgrade

wp-signup.php > . themes
wp-settings.php b |7 plugins
wp-mail.php index.php
wp-login.php

wp-load.php

wp-links-opml.php
¢ 8 wp-includes
wp-cron.php

> - wp=content

wp-config.php

wp-cenfig-sample.php
wp-comments-post.php
wp-blog-header.php
> B wp-admin

wp-activate.php

& readme.html

1 license.txt

index.php

» B cgi-bin

Once connected, navigate to the wp-content > themes directory (or folder). In other words, open
the wp-content directory (or folder) and then open the themes directory (or folder).

Sy " wp-content H “ smes
MName ¥
index.php

Once you're inside the themes directory (or folder), upload the entire unzipped "genesis" folder
from your computer's desktop . This folder must be named "genesis" and NOT "Genesis 2.0" or
some other variation. Also, the "genesis" folder cannot be nested inside another folder.

Repeat this process to upload an unzipped child theme folder. If the child theme's name contains
more than one word, the name of the folder may be separated with hyphens instead of spaces.
Also, just like with the "genesis" folder, the child theme folder cannot be nested inside another

folder.
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PLEASE NOTE: If your site is hosted on WordPress.com (example: mysite.wordpress.com),
you cannot install the Genesis Framework or new themes. This is a restriction on
WordPress.com-hosted sites.

2.3 Activating a Theme

After you've installed both the Genesis Framework and a child theme, you're ready to activate the
child theme. It is not necessary to activate the Genesis Framework theme as it will run quietly in
the background. Be sure the Genesis Framework is installed before you activate a child theme.

@ @& sampleSite B + New

@ Dashboard Installing Theme from uploaded file: genesis-sample.zip

A Posts Unpacking the package...
q: Media Installing the theme...
M Pages This theme requires a parent theme. Checking if it is installed...

P Comments The parent theme, Genesis 2.2.3, is currently installed.

Theme installed succesﬁy
® Genesis

Live Preview Return to Themes page

A Appearance

Themes

If you installed the child theme from inside the WordPress Dashboard, click the Activate link that
appears on the screen after the upload is complete.
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Sample Site

Dashboard

Posts
Media
Pages

Comments

Genesis

¥ Appearance

Background

Editor
Plugins
Users
Tools

Settings

Themes @)

Add New Search

Active: Atmosphere Pro Customize

e

Dotr‘ Theme Detalls fm
(=]

Altitude Pro 7| Activate

installed themes...

Agency Pro Theme

Ambiance Pro Theme

Welcome to my Website

Howdy, Sample User [l

Help

We help you find your dream home

J— [n—

= __JE RN
- [ =

Author Pro Theme

If you installed the child theme via FTP, log into your WordPress Dashboard and go to Appearance
> Themes to activate a theme directly on the themes page. Hover over any installed theme and
click the Activate button.
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\":" # Sample Site 4+ New

@ Dashboard Themes 0 Add New

A Posts
| New theme activated. Visit site

07 Media

[N Pages

P Comments
WELCOME TO OUR AGENCY.

g ian o B ferossgh thaossgfoh o craarive desigr Lok

® Genesis

M Appearance

Themes

Customize

Active: Atmosphere Pro Custornize Agency Pro Theme

After activating a child theme, it will appear first in the list of themes. When hovering over this
newly activated theme, you will see a Customize button that you can click to open the WordPress
Customizer and begin configuring your site settings.

Widgets

Menus

Introduction to the Basic Settings of the Genesis Framework

The Genesis Framework includes several basic settings and options that will help you customize
how your site looks and functions.

Some of these options can be configured within the WordPress Customizer and some can be
configured in the Genesis-specific settings pages.

Let's take a look at the settings and options available in the customizer first.

3.1 Theme Settings in the WordPress Customizer

Using the WordPress Customizer, you can edit your child theme's options and preview the changes
before publishing them to your live site.
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Once you've activated a child theme, you'll see several default WordPress settings and some

Genesis-specific settings in the customizer. The available settings will vary depending upon which

child theme is activated.

To get started, go to Appearance > Customize to access the customizer:

W @ sample Site
4% Dashboard

A Posts
£y Media
M Pages

P Comments

® Genesis

¥ Appearance

Themes

Widgets
Menus
Background
Editor

Once the customizer is open, you'll see a menu on the left and a preview of your site on the right:
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x Save & Publish

You are customizing 7] Saml !Ie Site

Sam"p\e Site A Genesis Framework Blog

Active theme o

Genesis Sample Theme one

Sample Layouts Templates Contact

Site Identity

Colors

Background Image . Primary Sidebar

- Sample Post With Threaded Widget Area

wid Comments This is the Primary Sidebar

idgets —_—
& ) Widget Area. You can add

February 1, 2012 by Sample User — & Comments (Edit) . -

Static Front Page content to this area by visiting
Thisi le of a WordP t Id edit this to put youriidgets Paneland ading

' is is an example of a WordPress post, you could edit this to pu .

Site Layout ) P D- ¥ P new widgets to this area.
information about yourself or your site so readers know where

Breadcrumbs you are coming from. You can create as many posts as you like in

Comments and Trackbacks order to share with your readers what is on your mind. Blah Blzh

Content Archives
Filed Under: Category #1
Tagged With: Threaded Comments

© Collapse <fmm—

The customizer menu on the left side shows the various options that are available for editing in
your theme. You can choose from options such as colors, background image, menus, and more.
The exact options available depend upon which theme you've activated.

On the right side, you'll see a live, interactive preview so that you can test each option in your
theme. All changes will appear as you select them.

To see the settings available within each option, click the title to open the expanded view.
Remember, the available settings will be different for each theme.

+ To see the interactive preview in full screen mode, click the Collapse triangle at the bottom
of the menu on the left side.

* When you are finished making all your changes, click Save & Publish. If you decide you do
not want to save the changes you've made, click the X to close the editor and dismiss your
changes.

Let's go over some of the common options available in the customizer.
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A Beginner's Guide to the Genesis Framework for WordPress

Site Identity

.

Customizing

Site Identity

Site Title
Sample Site
Tagline
A Genesis Framework Blog
Use for site title/logo:
Image logo ;

Site Icon

The Site lcon is used as a browser and app icon
for your site. Icons must be square, and at least
512px wide and toll.

No image selected

Select Image

You can set your site title, tagline, and upload your site icon (favicon) here. If you have activated a
theme that doesn't include the Header Image setting (see below), you can also choose whether

you'd like to display an Image logo or Dynamic text for your site title. AImost all our child themes,
however, do include the Header Image setting.
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Colors

b 4 Save & Publish

Customizing

Colors

Background Color

Select Color

Link Color

Change the default color for linked titles, menu
links, post info links and more.

Select Color

Accent Color

Change the default color for button hover and
the footer widget background.

- Select Color

Some themes allow the selection of a custom background color that will typically display behind
the content area of your site. Note: In some cases, the Background Color can be set here but it
won't show on the site if a Background Image is also being used since the background color is
located "behind" the background image.

Some themes also allow the selection of a custom Link Color and/or Accent Color. These colors are
typically applied to links, navigation menu link hovers, buttons, and footer widget backgrounds.
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A Beginner's Guide to the Genesis Framework for WordPress

Header Image

b 4 Save & Publish

Customizing

Header Image

While you can crop images to your liking
after clicking Add new image, your theme
recommends a header size of 260 = 100
pixels.

Current header

Mo image set

Add new image

If the theme you've activated on your site includes the Header Image option, you can upload a new
header image (or logo) or select an image from the Media Library. The best and recommended
size for this image will be displayed in the customizer panel.

Background Image

x Save & Publish

Customizing

Background Image

Background Image

Mo image selected

Select Image
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A Beginner's Guide to the Genesis Framework for WordPress

Some themes will allow the option to set a custom background image to be displayed behind the
content area of your site.

Menus

b 4 Save & Publish

You are customizing

(2]
Menus 0

Menu Locations

Primary Menu
(Currenthy set to: primary)

4+ Add a Menu

You can create and edit menus, as well as manage their location, within the customizer. The
available menu locations will depend upon which theme is activated on your site.

Click Menu Locations to see the available locations in your theme.
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b 4 Save & Publish

Customizing » Menus

Menu Locations

Your theme supports 2 menus. Select which
menu appears in each location.

You can also place menus in widget areas
with the Custom Menu widget.

Primary Mavigation Menu

Primary Menu %

Secondary Navigation Menu

— Select — =

Use the drop downs to select a navigation menu to display in each available location. Or, if you

prefer, you can set both locations to "Select” (in other words, turn them off) and use a Custom
Menu widget in a widget area instead.

x Save & Publish

You are customizing

e
Menus £

Menu Locations

Primary Menu <«

(Currenthy set to: primary)
4+ Add a Menu
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A Beginner's Guide to the Genesis Framework for WordPress

Click Add a Menu to create a new menu. Alternatively, you can click on the name of an existing
menu to edit it.

b 4 Save & Publish

You are customizing

7]
Menus £
Menu Locations

Primary Menu

® Add a Menu

Give the new menu a name and click Create Menu.
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x Save & Publish

Customizing » Menus

Secondary Menu

Secondary Menu

I =+ Add Items I

Delete Menu

Menu locations

Primary Navigation Menu
Secondary Mavigation Menu
Menu options

Automatically add new top-level pages to
this menu

Click Add Items to begin adding links to the navigation menu.
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x q Save & Publish

Customizing » Menus

Secondary Menu
Secondary Menu

X Add ltems

Delete Menu

Menu locations

Primary Navigation Menu
Secondary Navigation Menu

Menu options

Automatically add new top-level pages to
this menu

Custom Links

Posts

Pages

Categories

Tags

Click the titles to open the expanded view of the options or use the search field to locate items for
the menu. When you're finished adding all the menu items, click Save & Publish to preserve your

settings.

Widgets

Save & Publish

You are customizing

Widgets

Header Right
Primary Sidebar

Footer 1
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A Beginner's Guide to the Genesis Framework for WordPress

Some themes offer unique widget areas where you can add widgets to display important
information. The exact widget areas available will depend upon which theme is currently active on
your site.

Click on any available widget area to open a new panel where you can add and configure widgets.

4 Save & Publish

Customizing » Widgets

Primary Sidebar

This is the primary sidebar if you are using a
two or three column site layout option.

+ Add a Widget

In the new, open panel, click Add a Widget to display the available widgets that you can add to this
widget area.

x Save & Publish [N | |
Customizing » Widgets B Archives
Pf[mary Sidebar Amonthly archive of your site's
Posts.

This is the primary sidebar if you are using a
two or three column site layout option. Calendar

A calendar of your site’s Posts.
XK Add a Widget

[ Categories
A list or dropdown of categories.

Custom Menu
Add a custom menu to your sidebar.

M Genesis - Featured Page
Displays featured page with
thumbnails

A Genesis - Featured Posts
Dlsmlays featured posts with
thumbnails

Genesis - User Profile
Displays user profile block with
Gravatar

@ Meta

Login, RSS, & WordPress.org links.
M Pages
A list of your site’s Pages.

o Collapse
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You'll see a list of all the available widgets you can add to the available widget areas. You can click
directly on any widget you'd like to add. Scroll down the list or use the Search widgets box at the

top to locate the one you'd like to use.

Note: You can click the Collapse link at the bottom corner of the screen to temporarily hide the

Customizer and preview your changes in full screen mode.

< —

Customizing » Widgets

Primary Sidebar

This is the primary sidebar if you are using a
two or three column site layout option.

Custom Menu

Title:

Select Menu: — Select — =

Delete | Close

Reorder =+ Adda Widget

After selecting a widget, you can configure it however you'd like and then click Save & Publish to

preserve your changes.
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X — AT

Customizing » Widgets

Primary Sidebar

This is the primary sidebar if you are using a
two or three column site layout option.

Search

Custom Menu

Reorder =+ Add a Widget

Text =

—b Done

You can also click Reorder to rearrange the widgets into the order you prefer or to select a new
widget area to move the widget into.

Click Done when finished and then click Save & Publish to preserve your changes.

Static Front Page

x Save & Publish

Customizing

Static Front Page

Your theme supports a static front page.

Front page displays

* | Your latest posts

A static page
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The default setting for the front page is Your latest posts. This setting allows you to display a blog-
style front page. You can, however, select any page in your site to be displayed as the front page

instead of your latest posts.
x

Customizing

Static Front Page

Your theme supports a static front page.

Front page displays

Your latest posts

# A static page

Front page

L1

— Select —

Posts page

L1

— Select —

If you select A static page, you can select which existing page in your site will be displayed on your
front page.

You can also select which page will display your blog posts. This page should be different from the
one you've selected for the static front page and should not be set to use the Blog Page template.

PLEASE NOTE: If your theme uses the front page to display widgets, the widgets will be
displayed regardless of which setting you choose here. If you prefer to display your latest
posts or a static page on your front page, you'll need to remove all widgets from all front
page-related widget areas.
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Site Layout

.

Customizing

Site Layout

Select Default Layout

o

Content, Primary Sidebar

You can select the Default Layout for your entire site here.
Child themes may include one or more of the following options:
+ Content, Primary Sidebar
* Primary Sidebar, Content
+ Content, Primary Sidebar, Secondary Sidebar
+ Secondary Sidebar, Primary Sidebar, Content
+ Secondary Sidebar, Content, Primary Sidebar
+ Full Width Content
Site layout options can be added or removed with custom coding in the child theme.

Child themes with a widgetized home page will often work independently of this layout setting.
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Breadcrumbs

b 4 Save & Publish

Customizing

Breadcrumbs

Breadcrumbs on Homepage
v Breadcrumbs on Single Posts
Breadcrumbs on Pages
Breadcrumbs on Archives
Breadcrumbs on 404 Page

Breadcrumbs on Attachment/Media

Breadcrumbs are a navigation aid that allows users to keep track of their location on a website
relative to the home page. This option lets you define the pages where the Breadcrumbs will be
displayed.
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Comments and Trackbacks

x Save & Publish

Customizing

Comments and Trackb...

v| Enable Comments on Posts?
Enable Comments on Pages?
Enable Trackbacks on Posts?

Enable Trackbacks on Pages?

Genesis allows you to globally enable or disable Comments and Trackbacks on Posts and Pages. If

Comments or Trackbacks are disabled here, they cannot be enabled on an individual post or page
basis.

You'll find more information about Trackbacks here.
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Content Archives

The Content Archives settings allow you to control the way content displays on category, tag,

x Sawve & Publish

Customizing

Content Archives

These options will affect any blog listings
page, including archive, author, blog,
category, search, and tag pages.

Select one of the following

a

Display post content &

Limit content to how many characters?
(0 for no limit)

0
Display the featured image?

Featured image size
large (1024 x 1024) :
Featured image alignment

Left ;

Post Navigation Type

a

Numeric v

author, date, and taxonomy archive pages.

You can choose to display post content or to display post excerpts on archive pages.

+ Display post content: This setting allows you to display full posts on archive pages.

o |fyou'd like to limit the length of the content displayed while using the post content
setting, enter the number of characters (letters, numbers, and spaces) in the Limit
content to how many characters field. When you enter a number greater than 0
in this field, a Read More link will be automatically added to the end of the content
displayed. This option will strip any HTML from the content that is displayed on the
archive page, but it allows for more precise control over the length of the displayed

content.

+ Display post excerpts: This setting allows you to display post excerpts on archive pages.

o Only the first 55 words of the post will be displayed and the HTML will be stripped
from any content that's included in the excerpt. If a manual excerpt is set in a post, it
will be displayed in place of the first 55 words of the post content. Also, a manual
excerpt will display any HTML that's included in the excerpt.
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The Featured Image setting allows you to show a thumbnail of the first attached image or the
currently set featured image for the post.

Check the box to enable featured images. The Featured image size list is populated by the
available image sizes defined in the theme. The Featured image alignment setting allows you to
choose whether the featured images on the archive pages should be aligned to the left or right of
the content.

PLEASE NOTE: To avoid displaying duplicate images, featured images should not be used
when displaying full post content.

Also, if the featured images are not displaying at the correct size, you may need to use a
Regenerate Thumbnails plugin to change the automatically generated thumbnail size.

The Post Navigation Type setting allows you to select one of two navigation display methods:
Previous/Next or Numeric. These navigation links will be visible on category, tag, author date, and
taxonomy archive pages, pages using the blog page template, and on blog style home pages.

3.2 Theme Settings Screen

Once you've activated a child theme, you'll see a new Genesis menu item in the WordPress
Dashboard.

\"-." @A Sample Site 4+ New Howdy, Sample User [l

Help

@ Dashboard Theme SettingS Reset Settings
A Posts
Information
07 Media
[N Pages Version 2.2.5
B Comments
: Released: December 17, 2015
©® Genesis
Theme Settin|
s Updates v| Enable Automatic Updates

SEO Settings

Import/Export
If you provide an email address above, you will be notified via email when a new version of Genesis is available.
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This menu item includes three sub-menu options: Theme Settings, SEO Settings, and Import/Export.
Sometimes child themes and Genesis-specific plugins will add additional sub-menu items in this
section. They may also add additional content on the default Genesis settings pages.

The Theme Settings page contains general options to control the way your theme will behave.
Some of these settings are also available in the WordPress Customizer.

Each of the boxes on the page can be collapsed or expanded by clicking the box header and can
be dragged into any order you wish. They can also be hidden by clicking on the Screen Options tab
in the top right corner of the screen and unchecking the boxes you don't want to see.

Let's look at each of the Theme Settings.

Information
Information
Version 225
Released: December 17, 2015
Updates v| Enable Automatic Updates

If you provide an emaif address above, you will be notified via email when a new version of Genesis is available.

Checking the Enable Automatic Updates option will allow your server to check for available updates
to the Genesis Framework. No updates will be made without your interaction. It's a good idea to
leave this option enabled.

If automatic updates are enabled, you can enter your email adress to receive an email alert about
the update when it's available.
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Custom Feeds

Custom Feeds A

Enter your custom feed URL:

Redirect Custom Feed?

Enter your custom comments

feed URL:
Redirect Custom Comments Feed?

If your custom feed(s) are not handled by Feedblitz or Feedburner, do not use the redirect options.

If you use services like Feedblitz or Feedburner to handle your RSS feed(s), you can use this
function to redirect your site's native feed to your custom feed.

Checking the Redirect Custom Feed and/or the Redirect Custom Comments Feed option(s) will redirect
all traffic to the custom URLs that you enter instead of the default WordPress-generated feeds.

If you wish to use the default feeds that WordPress generates, leave these boxes empty.

Default Layout

Default Layout i

Select Default Layout 1 1 1

You can select the Default Layout for your entire site in the WordPress Customizer or here on the
Genesis Theme Settings screen. Child themes may include one or more of the following options:

+ Content, Primary Sidebar

* Primary Sidebar, Content

+ Content, Primary Sidebar, Secondary Sidebar
+ Secondary Sidebar, Primary Sidebar, Content
+ Secondary Sidebar, Content, Primary Sidebar
+ Full Width Content
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Site layout options can be added or removed with custom coding in the child theme.

Child themes with a widgetized home page will often work independently of this layout setting.
Breadcrumbs

Breadcrumbs

Enable Breadcrumbs on: Homepage
| Single Posts
Pages
Archives
404 Page

Attachment/Media

Breadcrumbs are a navigation aid that allows users to keep track of their location on a website
relative to the home page. This option lets you define the pages where the Breadcrumbs will be
displayed. Breadcrumbs can be defined within the WordPress Customizer or here on the Genesis

Theme Settings screen.

Comments and Trackbacks

Comments and Trackbacks

Enable Comments ¥| on posts?
on pages?
Enable Trackbacks on posts?
on pages?

Genesis allows you to globally enable or disable Comments and Trackbacks on Posts and Pages. If
Comments or Trackbacks are disabled here, they cannot be enabled on an individual post or page
basis. You can enable or disable them in the WordPress Customizer or here on the Genesis Theme
Settings screen.
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You'll find more information about Trackbacks here.

Content Archives

Content Archives

Display Entry content +
Limit content to 0 characters
Featured Image ¥ Include the Featured Image?

Image Size: large (1024 x 1024) B

A

Image Alignment: Left v

Entry Pagination Numeric v

These options will affect any blog listings page, including archive, author, blog, category, search, and tag pages.

The Content Archives settings allow you to control the way content displays on category, tag,
author, date, and taxonomy archive pages. These settings can be defined in the WordPress
Customizer or here on the Genesis Theme Settings screen.

You can choose to display entry content or to display entry excerpts on archive pages.

+ Entry content: This setting allows you to display full posts on archive pages.

o |f you'd like to limit the length of the content displayed while using the entry content
setting, enter the number of characters (letters, numbers, and spaces) in the Limit
content to field. When you enter a number greater than 0 in this field, a Read More
link will be automatically added to the end of the content displayed. This option will
strip any HTML from the content that is displayed on the archive page, but it allows
for more precise control over the length of the displayed content.

+ Entry excerpts: This setting allows you to display post excerpts on archive pages.

o Only the first 55 words of the post will be displayed and the HTML will be stripped
from any content that's included in the excerpt. If a manual excerpt is set in a post, it
will be displayed in place of the first 55 words of the post content. Also, a manual
excerpt will display any HTML that's included in the excerpt.
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The Featured Image setting allows you to show a thumbnail of the first attached image or the
currently set featured image for the post.

After checking the box to enable featured images, two new options will appear. The Image Size list
is populated by the available image sizes defined in the theme. The Image Alignment setting
allows you to choose whether the featured images on the archive pages should be aligned to the
left or right of the content.

PLEASE NOTE: To avoid displaying duplicate images, featured images should not be used
when displaying full post content.

Also, if the featured images are not displaying at the correct size, you may need to use a
Regenerate Thumbnails plugin to change the automatically generated thumbnail size.

The Entry Pagination setting allows you to select one of two navigation display methods: Previous/
Next or Numeric. These navigation links will be visible on category, tag, author date, and taxonomy
archive pages, pages using the blog page template, and on blog style home pages.

Blog Page Template

Blog Page Template

These settings apply to any page given the "Blog" page template, not the homepage or post archive pages.

Display Category All Categories

Ak

Exclude Categories

Category 1Ds, comma separated - 1,2,3 for example

Posts per Page 5

The Blog Page Template settings govern pages that use the Blog Template. A page that is set to
use this template will display a list of recent posts similar to the home page view of a blog style
home page.
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You can use the drop down menu to select a specific category to display. You can also exclude
categories by ID, as well as select how many posts you'd like to display on this page.

PLEASE NOTE: A page using the blog page template should not be used as a static home
page.

Header and Footer Scripts

Header and Footer Scripts

Header Scripts

This code will output immediately before the closing </head> tag in the document source.

Footer Scripts

This code will output immediately before the closing </body> tog in the document source.

The Header and Footer Script text areas will allow you to add code for tools such as statistics
tracking and other 3rd party services that require code to be added to the header or footer area of

your site. One notable example would be the code for Google Analytics tracking which can be
added to the header scripts box.
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3.3 SEO Settings

.\:\ # Sample Site B 4+ New Howdy, Sample User [l

) Screen Options Help

ST Genesis - SEO Settings Reset Settings
A Posts

Sitewide Settings
07 Media
M Pages . : . . .

Section Headings v Use semantic HTMLS page and section headings throughout site?
¥ Comments

Document Title i i 7
O Genesis Add site name to <title> on inner pages?

Document Title Separator: -

Theme Settings If the title consists of two parts (original title and optional addition), then the separator will go in between them.

SEO Settings
Import/Export Document Title Order Additions on right %

Determines which side the added title text will go on.

¥ Appearance

A Plugins

0 Homepage Settings

as Users

4~ Tools
Document Head Settings
Settings

© Collapse menu Robots Meta Settings

Save Settings Reset Settings

When Genesis SEO (search engine optimization) is active, you will see the SEO Settings menu
option in the WordPress Dashboard.

If any of several advanced SEO plugins are active, the Genesis SEO settings will be automatically
disabled to avoid duplicate SEO related fields from being displayed for your site.

The default settings are recommended for most users. For more specific information about the
Genesis SEO settings please check out this tutorial.
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3.4 Import/Export

\"-," # SampleSite B 0 4 New Howdy, Sample User [l

) Help
L SRR Genesis - Import/Export
A Posts
Import Genesis Settings File Upload the data file ( .json ) from your computer and we'll import your settings.
QJ Media Choose the file from your computer and click "Upload file and Import"
[N Pages Upload File (Maximum Size: 128M): Choose File | NO file chosen
¥ Comments Upload File and Import
© Genesis
Theme Settings Export Genesis Settings File When you click the button below, Genesis will generate a data file ( .json ) for you to save to your computer.
SEOQ Settings Once you have saved the download file, you can use the import function on another site to import this data.
Import/Export Theme Settings
SEOQ Settings
¥ Appearance
Download Export File

K¢ Plugins

The Import/Export option allows you to import or export Genesis Settings for use as a backup or
on a different site.

This is specific to Genesis settings and does not include a backup of your posts, pages, or images,
which is what the built-in WordPress import/export feature does.

The Genesis export feature also does not include settings for plugins, widgets, or specific settings
related to posts, pages, terms, or users.

Introduction to Configuring the Home Page of Your Genesis
Site

Depending upon which child theme you've chosen for your site, there are a couple options for the
display of content on your home page. Some child themes include custom widget areas that allow
you use various types of widgets to add content to your home page. Other themes include a blog-
style home page which displays your latest blog posts in a list format. If you prefer, you can set
your site to display a specific page as the home page instead.
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4.1 Custom Home Page

\f,‘ @A SampleSite B 0 4 New Howdy, Sample User [l

§ Help
@ Dashboard Reading Settings
A Posts -
I Front page displays & Your latest posts I
07 Media
A static page (select below)
I Pages
P Comments Front page:
[l Portfolio Posts page:
@ Genesis
¥ Appearance Blog pages show at most 5 posts
K¢ Plugins
& Users Syndication feeds show the 10 o
most recent
# Tools
Settings For each article in a feed, s Full text
show
General Summary
Writing
Reading Search Engine Visibility Discourage search engines from indexing this site
Discussion It is up to search engines to honor this request.

Media

© Collapse menu

Many Genesis child themes available from StudioPress include a custom home page which
includes widgets to add content to the home page.

To use this type of home page, go to Settings > Reading and set the front page to display Your
latest posts.

PLEASE NOTE: Since the latest posts won't be displayed when you add content to the home
page widget areas, you can create a page and assign the Blog page template to show a blog-
style list of your latest posts on another page of your site.
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\7,‘ @ SampleSite B 0 4 New Howdy, Sample User [l

@ Dashboard Widgets —

Screen Options Help

A Posts : )
o Available Widgets Primary Sidebar
41 Media To activate a widget drag it to a sidebar or click on it. To
H P deactivate a widget and delete its settings, drag it back.
[ Pages Front Page 1
¥ Comments Archives

’ Front Page 2
@ Genesis A monthly archive of your site’s Posts. B
¥ Appearance Calendar Front Page 3
Themes A calendar of your site’s Posts.
Customize Front Page 4
Widgets Categories
Menus Alist or dropdown of categories. Front Page 5
Header
Editor Custom Menu

Front Page 6

‘, ngins Add a custom menu to your sidebar.
& Users Genesis - Featured Page Front Page 7

#~ Tools

Displays featured page with thumbnails

Settings Footer 1
Genesis - Featured Posts

© Collapse menu

Displays featured posts with thumbnails After Entry

Genesis - User Profile

Displays user profile block with Gravatar

The home page will often include Front Page widget areas that are registered by the child theme.
These areas can be configured via the WordPress Customizer or on the Widgets screen via
Appearance > Widgets.

All child themes include Theme Setup Guides that can be accessed in the Member's Area at
http://my.studiopress.com/downloads/. These guides will show you how to set up your front page
widgets to resemble the theme's demo.

4.2 Blog-Style Home Page

Another common home page is the blog-style home page. This type of home page displays the
latest blog posts in list form and requires no additional configuration.

If the child theme you've chosen uses a custom home page, but you would prefer to use the blog-
style layout, do not add any widgets to the home page-specific widget areas.
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PLEASE NOTE: In some of our older themes, you may need to rename the home.php file to
home-old.php via FTP or the web based file manager provided by your host to remove the

requirement to use widgets on the home page.

4.3 Static Home Page

@ Dashboard

A Posts
07 Media
N Pages

P Comments
® Genesis

2 Appearance
K¢ Plugins

= Users

# Tools

Settings

General
Writing
Reading
Discussion
Media

Permalinks

© Collapse menu

@ & sampleSite B 0 + New

Reading Settings

Front page displays Your latest posts

I * A static page (select below) I

Front page: — Select —

Posts page: — Select —

Blog pages show at most 5 posts
Syndication feeds show the

10 items
most recent
For each article in a feed, o Full text
show

Summary

Search Engine Visibility

It is up to search engines to honor this request.

a

“r

Discourage search engines from indexing this site

Howdy, Sample User [l

Help

If you prefer, you can display a single, static page on the home page instead of widgets or a blog-
style list of latest posts.

This can be accomplished by creating and publishing a Page in the WordPress admin panel and

then going to Settings > Reading and setting Front page displays to A static page.

Now you're ready to choose which page should be used for the home page (or front page) and for
the posts pages.

1. Use the drop down to select which page will be displayed on the Front page.
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2. Use the drop down to select which page will be the Posts page, the page on your site
that lists your latest blog posts.

Introduction to Setting Up a Navigation Menu

Genesis uses the built-in WordPress menu feature to create and display navigation menus. You
can create and manage menus either in the WordPress Dashboard or inside the WordPress

Customizer.

5.1 Create a Menu in the WordPress Customizer

.

You are customizing

e
Menus 2

Menu Locations

_’- + Add a Menu

After you have created some pages and/or blog posts, you can create a new menu in the
WordPress Customizer by going to Appearance > Customize > Menus. Click Add a Menu to get

started.
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X Save & Publish

You are customizing

(7]
Menus e

Menu Locations

| X Add a Menu |

—>

Give your new menu a name. This name is for your reference only. Click Create Menu to apply the
new name and begin building your menu.

x Save & Publish

Customizing » Menus

Primary Menu

Primary Menu

4 <+ Add ltems

Delete Menu

Menu locations

Primary Navigation Menu
Secondary Navigation Menu

Footer Navigation Menu

Menu options

Automatically add new top-level pages to
this menu
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Click Add Items to select items to add to the menu.

You can also check the box in the Menu Options section to automatically add any top-level pages to
this menu. This means that when you create a new page on your site and it's not a sub-page, a link
to the page will automatically be added to this menu.

X Save & Publish

Customizing » Menus

Primary Menu
Primary Menu

X Add ltems

Celete Menu

Menu locations

Primary Navigation Menu

Secondary Navigation Menu

Footer Navigation Menu
Menu options

Automatically add new top-level pages to
this menu

Custom Links

Posts

Pages

Categories

Tags

On the right side of the customizer panel, you can select Custom Links, Posts, Pages, Categories, or

Tags to add to your new menu. Click the arrows to open each option.
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x  — T

Customizing » Menus

Primary Menu

Custom Links

Posts
Primary Menu

Pages
About Page XX
- <= Home Custom Link
¥ Add ltems |
v About Page
Delete Menu
Menu locations + Blog Page
Primary Mavigation Menu <4 Landing Page Page
Secondary Navigation Menu
oy = == Column Classes Page
Footer Navigation Menu
= Columns Page Page
Menu options
Automatically add new top-level pages to + Contact Page Page
this menu o o
Categories
Tags

Click on each item you'd like to add. When you're finished and all the items you've selected appear
on the left side of the customizer panel, click Save & Publish to preserve your settings.

You are customizing

Menus

Menu Locations

Primary Menu

4+ Add a Menu
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If desired, click Menu Locations to assign this menu to an available location within the activated
child theme.

x  — D

Customizing » Menus

Menu Locations

Your theme supports 3 menus. Select which
menu appears in each location.

You can also place menus in widget areas
with the Customn Menu widget.

Primary Navigation Menu

— Select — :

Secondary Navigation Menu

— Select — :

Footer Navigation Menu

— Select — =

Use the drop downs to select a menu for each location.

Click Save & Publish to preserve your settings.

PLEASE NOTE: The available menu locations depend upon which child theme is activated on
your site. Also, you don't need to select locations for your menus if you are going to use a
Custom Menu widget inside an available widget area instead.

Refer to the setup guide for your child theme to see how the menus are used within the
theme's demo. All child themes include Theme Setup Guides that can be accessed in the

Member's Area at http://my.studiopress.com/downloads/.
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5.2 Create a Menu in the WordPress Dashboard

\‘:" # Sample Site BB <+ New Howdy, Sample User

) Screen Options Help
@ Dashboard MenUS Manage in Customizer
A Posts Edit Menus
07 Media
L] Pages Edit your menu below, o

P Comments

® Genesis

Give your menu a name above, then click Create Menu.

M Appearance

Themes

Customize m
Widgets

Menus

Header

Editor

K- Plugins

= Users

4~ Tools

Settings

© Collapse menu

After you have created some pages and/or blog posts, you can create a new menu in the
WordPress Dashboard by going to Appearance > Menus and clicking the create a new menu
link.

www.studiopress.com - 3/6/2017 v.3.0 Page 49



A Beginner's Guide to the Genesis Framework for WordPress

Screen Options Help
Menus Manage in Customizer
Edit Menus Manage Locations
Select a menu to edit:  — Select — ¥ | Select  orcreate a new menu.
Pages Menu Name Create Menu

Give your menu a name above, then click Create Menu.

Create Menu

Posts
Custom Links

Categories

Give your new menu a name. This name is for your reference only. Click Create Menu to apply the
new name and begin building your menu.
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Secreen Options Help
MenUS Manage in Customizer

Edit Menus Manage Locations

Edit your menu below, or create a new menu.

Pages Menu Nome  Primary Menu Save Menu

Most Recent  View All  Search Menu Structure

Add menu items from the column on the left.
bout
Blog
Column Classes

Menu Settings
Columns Page

Contact Page Auto add pages Automatically add new top-level pages to this menu
Page Templates Theme locations Primary Navigation Menu

Landing Page Secondary Mavigation Menu

Blog Page Footer Navigation Menu

Select All _’ Add to Menu
Delete Menu
Posts 1

Custom Links

Categories

From the left side of the screen, you can select Pages, Posts, Custom Links, or Categories to add to
your new menu. Click the arrows to open each section and then check the boxes of the items
you'd like to add. Click Add to Menu after making your selections within each panel.

@ @A samplesite B Howdy, Sample User [l

@ Dashboard Boxes

v| Pages |v|Posts |v/| Custom Links |v Categories Tags

A Posts

Show advanced menu properties

07 Media

v'| Title Attribute Link Target CSS Classes Link Relationship (XFN) Description

N Pages

_> Screen Options

¥ Comments Menus Manage in Customizer

If any options are missing from the menu editor, click the Screen Options tab in the upper right
corner and check the boxes to enable the options you need. Click the tab again to minimize the
Screen Options panel.
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@ @& Sample Site

@& Dashboard

A Posts
0] Media
N Pages

P Comments
® Genesis

X Appearance
Themes
Custornize
Widgets
Menus
Header
Editor

A& Plugins
o Users
4 Tools
Settings

© Collapse menu

Menus Manage in Customizer

Edit Menus Manage Locations

Edit your menu below, or create a new menu.

Pages

Most Recent  View All  Search

About

Blog

Column Classes

Columns Page

Contact Page

Page Templates
Landing Page
Blog Page

Select All Add to Menu

Posts
Custom Links

Categories

Menu Name  Primary Menu

Menu Structure

Howdy, Sample User [l

Screen Options Help

— =3

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional

configuration options.

Sample Page

Sub Page 1.1

About

Blog

Contact Page

Page

Page

Page

Page

Page

Menu Settings
Auto add pages

Theme locations

Automatically add new top-level pages to this menu

Primary Navigation Menu
Secondary Navigation Menu

Footer Navigation Menu

When you're finished building your menu, click Save Menu to preserve your settings.

If desired, you can assign this menu to any available location in your activated theme by checking
the appropriate box that appears below the menu.

PLEASE NOTE: The available menu locations depend upon which child theme is activated on

your site. Also, you don't need to select locations for your menus if you are going to use a
Custom Menu widget inside an available widget area instead.

Refer to the setup guide for your child theme to see how the menus are used within the
theme's demo. All child themes include Theme Setup Guides that can be accessed in the

Member's Area at http://my.studiopress.com/downloads/.
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\"-," # Sample Site

@ Dashboard

A Posts
07 Media
N Pages

P Comments

© Genesis

M Appearance

Themes
Customize

Widgets

=+ New

Men US Managein Custom

izer

Edit Menus Manage Locations

Your theme supports 3 menus. Select which menu appears in each location.

Theme Location
Primary Navigation Menu
Secondary Navigation Menu

Footer Navigation Menu

B «—

Assigned Menu
— Select a Menu —
— Select a Menu —

— Select a Menu —

Y
v
Y

v

Y
v

Howdy, Sample User [l

Help

Use new menu
Edit | Use new menu

Use new menu

Alternatively, you can click the Manage Locations tab and manage the location of all your menus
at one time. Be sure to click Save Changes to preserve your settings.

5.3 Create a Non-Clickable Menu Item

Pages

Posts

Custom Links

URL

Link Text

Categories

Start Here

Add to Menu

When you want to include a top-level menu item that is not clickable, add a Custom Link to your

menu.
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Add the # symbol in the URL field to make this link inactive. In other words, if someone tries to
click on the Link Text, they will not be forwarded to a new page.

5.4 Create a Drop Down Menu Item

Screen Options Help
Men LIS Manage in Customizer
Edit Menus Manage Locations
Edit your menu below, or create a new menu.
Pages Menu Name  Primary Menu ——l m

Most Recent | View All  Search Menu Structure
el B

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional

Blog Page configuration options.
Landing Page
Sample Page
Sample Page Page
Sub Page 1.1
Sub Page 2.1 Sub Page 1.1 Page —
Sub Page 3.1
Sub Page 3.2
Sub Page 3.3 About Page
Select All Add to Menu
Blog Page
Posts
Contact Page Page
Custom Links
Categories Menu Settings
Auto add pages Automatically add new top-level pages to this menu
Theme locations Primary Navigation Menu

Secondary Navigation Menu
Footer Navigation Menu

When adding new items to your menu, you can create a drop down menu experience by clicking
and dragging the menu item until it becomes indented in the list. You'll see a dashed border
appear indicating the new location of the menu item when you let go of the item.

Click Save Menu to preserve your settings.

Introduction to the Common Widget Areas in Genesis Child
Themes

Many Genesis child themes include common widget areas to which you can add any type of
content you'd like:

« Header Right Widget Area
« Primary Sidebar Widget Area
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+ After Entry Widget Area
+ Footer Widget Areas

Some child themes include extra widget areas which are used to populate the home page or other
specialized area of the site.

@& Dashboard

A Posts
037 Media
| Pages

P Comments

® Genesis

M Appearance

Themes
Customize
Widgets
Menus
Background
Editor

A& Plugins

& Users

& Tools
Settings

@ Collapse menu

@@ @ sampleSite P

=+ New

Archives

A monthly archive of your
site’s Posts.

Categories

A list or dropdown of
categories.

Genesis - Featured Page

Displays featured page with
thumbnails

Genesis - User Profile

Displays user profile block
with Gravatar

Pages

A list of your site’s Pages.

Recent Posts

Your site’s most recent Posts.

Widers

Available Widgets

To activate a widget drag it to a sidebar or click on it. To deactivate
a widget and delete its settings, drag it back.

Calendar

A calendar of your site’s
Posts.

Custom Menu

Add a custom menu to your
sidebar.

Genesis - Featured Posts

Displays featured posts with
thumbnails

Meta

Login, R5S, & WordPress.org
links.

Recent Comments

Your site’s most recent
comments.

RSS

Entries from any RSS or Atom
feed.

Header Right

This is the header widget area. It typically
appears next to the site title or logo. This
widget area is not suitable to display every
type of widget, and works best with a
custom menu, a search form, or possibly a

text widget.

Primary Sidebar

Secondary Sidebar

Footer 1

Footer 2

Footer 3

Howdy, Sample User [l

Screen Options

Help

Widgets can be configured in the WordPress Customizer or on the Appearance > Widgets screen
of the WordPress Dashboard.

Learn more about managing widget areas here.
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6.1 Header Right Widget Area

Header Right

This is the header widget area. It typically appears next to the
site title or logo. This widget area is not suitable to display every
type of widget, and works best with a custom menu, a search
form, or possibly a text widget.

Some child themes include a Header Right widget area which, when used, displays next to the site
title or logo. Since this widget area is often located in limited space, this widget area is best suited
for small amounts of content like a custom menu, a search form, or a text widget.

PARALLAX PRO SAMPLE TYPOGRAPHY COLORS CONTACT

For example, many users place a Custom Menu widget in this area to display their site's navigation
menu.

6.2 Primary Sidebar Widget Area

Primary Sidebar

This is the primary sidebar if you are using a two or three
column site layout option.

If the child theme that's activated on your site includes a layout that includes a sidebar (ex. Content,
Sidebar or Sidebar, Content) in the Genesis Theme Settings, the Primary Sidebar widget area will be
available.

You may use any widgets you like in this area.
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Genesis Framework Somple Layouss Templates
Supparts HTML5 & Mobie Responsive

Sample Post With Threaded EmalNewsltter
Comments
S 12015 Gt

For example, the Genesis Sample Child Theme uses the Primary Sidebar widget area to display an

Email Newsletter sign up form, social icons, and a list of recent posts.

6.3 After Entry Widget Area

After Entry

Widgets in this area will display after single post entries.

The After Entry widget area is displayed at the end of all single post entries (blog posts) on your

Site.

You may use any widgets you like in this area.
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A Beginner's Guide to the Genesis Framework for WordPress

/ri\v

AProfessional Theme for Minimalists

Free Newslelter

Comments

For example, some users use this widget area to display a newsletter sign up form.
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6.4 Footer Widget Areas

Footer 1

Footer 1 widget are

Footer 2

Footer 2 widget ar

Footer 3

Footer 3 widget ar

ad.

Some child themes include Footer widget areas which display below the site content and above

the site footer.

You may use any widgets you like in these areas. Note: If you don't place a widget in the first
Footer widget area, the other Footer widget areas will not activate.
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Say hello.

WORKSTATION PRO is a WordPress theme In the heart of downtown, our little office sitson  Feel free to contact us the old fashioned way.
made on the Genesis Framework. the second floor of a quaint historic building. Sometimes it's nice to talk to a real person.

Learn More 165 1202 Main Street t:+1 (555) 555-1234
Purchase Theme Anytown, USA f:+1 (555) 555-5678

Copyright @ 2015 - Workstation Pro Theme on Genesis Framework - WordPress - Log in

For example, some users use these widget areas to display contact information and links to more
information.
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Introduction to the Widgets Included in the Genesis
Framework

@ & sampleSite $ 0 -+ New

@ Dashboard W|dget5 Manage in Customizer
A Posts X ’
Available Widgets
o 7
1 Media To activate a widget drag it to a sidebar or click on it. To deactivate a widget and delete its
] Pages settings, drag it back.
¥ Comments Archives Calendar
© Genesis Amanthly archive of your site's Posts. A calendar of your site's Posts.
M Appearance Categories Custom Menu
Themes Alist or dropdown of categories. Add a custom menu to your sidebar.
Customize
Genesis - Featured Page o Genesis - Featured Posts e
Widgets
Menus Displays featured page with thumbnails Displays featured posts with thumbnails
y pag play P
Background
Editor Genesis - User Profile e Meta
4 Plugins Displays user profile block with Gravatar Login, RSS, & WordPress.org links.
- Users Pages Recent Comments
Tools
+ Alist of your site’s Pages. Your site’s most recent comments.
Settings
Recent Posts RSS
© Collapse menu
Your site’s most recent Posts, Entries from any RSS or Atom feed.
Search Tag Cloud
A search form for your site. A cloud of your most used tags.
Text

Arbitrary text or HTML.

When you install the Genesis Framework and activate a child theme, three Genesis-specific widgets
are added to the Available Widgets that are listed on the screen located in Appearance > Widgets.

1. Genesis - Featured Page widget
2. Genesis - Featured Post widget
3. Genesis - User Profile widget

Let's take a look at the Genesis Featured Page widget.

7.1 Genesis - Featured Page Widget

The Genesis Featured Page widget is often used to display a featured image and an excerpt of the
content from a single page. It can be used in any widget area, such as a front page-specific widget
area, a sidebar, or a footer.
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You can use this widget as many times as you like, with different configurations in each instance of
the widget.

To add the widget to a widget area, go to Appearance > Customize > Widgets. Alternatively, you
can go to Appearance > Widgets.

The widget can be configured using the settings described below:

REN

Genesis - Featured Page

Title:

b

Page: About

Show Featured Image
Image Size: thumbnail (150x150) %
Image Alignment: - None - 4

Show Page Title

Show Page Content

Content Character Limnit:

More Text:

Delete | Close m

0000 000 00

. Title: Enter a title for this widget (optional). This title will be displayed at the top of the

widget content.
Page: Use the drop down to select which page you'll be featuring.

. Show Featured Image: Check the box to display the featured image that's been

assigned to the page.
Image Size: Use the drop down to select what size at which the featured image will be
displayed.

. Image Alignment: Use the drop down to select whether the featured image should be

aligned to the left, right, or centered over the text content.

Show Page Title: Check this box if you'd like to display the title of the page being
featured.

Show Page Content: Check this box if you'd like to display the page content. If you want
to display the title and featured image only, leave this option unchecked.
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8. Content Character Limit: If you are showing the page content (above), enter a number
here to limit how many characters of that content should be displayed in the widget.
This will remove HTML formatting from the portion of content being displayed.

9. More Text: If you entered a content character limit (above), a more link will be
automatically included at the end of the abbreviated content. Enter the text you'd like to
use, such as Continue Reading. This text will automatically be linked to the featured page.

Once you have completed the widget configuration, be sure to click Save at the bottom of the
widget to preserve your settings.

7.2 Genesis - Featured Posts Widget

The Genesis Featured Posts widget is often used to display a featured image and an excerpt of the
content from one or more blog posts. It can be used in any widget area, such as a front page-
specific widget area, a sidebar, or a footer.

You can use this widget as many times as you like, with different configurations in each instance of
the widget.

To add the widget to a widget area, go to Appearance > Customize > Widgets. Alternatively, you
can go to Appearance > Widgets.

The widget can be configured using the settings described below:
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©© 00

Genesis - Featured Posts

Title:

Category: Show Post Title

All Categories

:
e Nurnber of Posts to Show: 1

o Number of Posts to Offset: 0

e Order By: Date

Sort Order: More Text (if applicable):

Show Post Info

[post_date] By [post_author_pos!

Content Type:
Show Excerpt

Limit contentto 0 characters

00 © 00

Descending (3,2, 1) # [Read More...]

o Exclude Previously Displayed
Posts?

o Exclude Sticky Posts?

Show Author Gravatar

To display an unordered list of more
posts from this category, please fill
out the information below:

Title:

Gravatar Size:

Small (45px)

Number of Posts to Show:

©06 0

Gravatar Alignment: - None-
Show Category Archive Link

Link Text:
More Posts from this Category

060 00 ©

Show Featured Image

@ Image Size:

thumbnail (150x150) 3

Image Alignment: - None- %

Delete | Close m

. Title: Enter a title for this widget (optional). This title will be displayed at the top of the

widget content.

. Category: Use the drop down to select which category you'd like to feature. You can

feature all categories or a single category.

. Number of Posts to Show: Enter the number of posts you'd like to display in this
widget.
Number of Posts to Offset: Enter the number of posts to offset (or skip). Offset is used

when you have Featured Posts appearing elsewhere and you don't want to repeat posts
in those areas. Offsetting by 1 will show the next most recent post.

. Order by: Use the drop down to select the order in which the posts should be

displayed.

Sort Order: Use the drop down to select whether the order should be descending or
ascending.

Exclude Previously Displayed Posts?: Check the box to exclude posts that have
already been displayed on the page. This is useful when a post has been assigned to
more than one category and there are more than one Genesis Featured Posts widget on
the page.

Exclude Sticky Posts: Check the box to prevent sticky posts from being displayed.

. Show Author Gravatar: Check to display the post author’s gravatar with each post. For

this to display, the author must have a gravatar from http://gravatar.com associated
with the email address in his or her profile.
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10. Gravatar Size: If you have enabled the author gravatar, use the drop down to select the
size of the gravatar.

11. Gravatar Alignment: Use the drop down to select whether the gravatar image should
be aligned to the left or right of the text.

12. Show Featured Image: Check the box to display the featured image that's been
assigned to each post. Genesis will automatically assigned the first image that's been
uploaded directly to the post as the featured image. Alternatively, the featured image
can be set in the post editor page.

13. Image Size: Use the drop down to select what size at which the featured image will be
displayed.

14. Image Alignment: Use the drop down to select whether the featured image should be
aligned to the left, right, or centered over the text content.

15. Show Post Title: Check the box if you'd like to display the title of each post being
featured.

16. Show Post Info: Check the box to display the post info including the post date, author
and comment link. You can then customize as desired.

17. Content Type: Choose whether to display the Excerpt, Content, a Content Limit, or No
Content. See below for more information.

18. Limit Content: Use this option with the Show Content Limit setting above. It functions
just like the excerpt, but gives you more control over the number of characters shown.

19. More Text: If you choose to display a Content Limit, enter the desired more text, such
as [Read More...]. This text will automatically be linked to the post.

20. Unordered List of More Posts: This option displays just the titles of additional posts
from the category or categories chosen, and will automatically exclude the posts already
shown above the list.

21. Title: If you would like to display the unordered list of more posts from the selected
category, add a title for the list (ex. More Posts from this Category).

22. Number of Posts to Show: If you would like to display the unordered list of more posts
from the selected category, enter the number of posts to show.

23. Show Category Archive Link: If you have selected a single category to display in this
widget, check the box to display a link to the rest of the posts in this category. Note: If
you have the widget set to show All Categories, this link will not be displayed.

24. Link Text: Enter the text you'd like to display in the link (ex. More Posts from this
Category).

Once you have completed the widget configuration, be sure to click Save at the bottom of the
widget to preserve your settings.
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Content Types Explained

Excerpt: Only a portion of the content of the post will be displayed. The excerpt is a teaser that
shows the first 55 words of the post's content. All HTML tags and graphics are stripped from the
excerpt's content.

Content: The complete content of the post, including images, will be displayed. We don't
recommend this setting if you have large images in the post content. Use this setting along with
the more tag inside the post if you want to show an excerpt of the post that contains images and
HTML. Using the more tag within the post allows you to designate the stopping point of the excerpt
(ex: everything above the more tag will display in the widget).

Content Limit: Only a portion of the content of the post will be displayed. This setting is similar to
showing an excerpt, but you can define the exact number of characters displayed.

No Content: No content from the post will be displayed. This setting is useful if you only want to
display the title or the title and featured image.

7.3 Genesis - User Profile Widget

The Genesis User Profile widget is used to display a user's gravatar and bio or custom text. It can
be used in any widget area, such as a front page-specific widget area, a sidebar, the after entry
area, or a footer.

You can use this widget as many times as you like, with different configurations in each instance of
the widget.

To add the widget to a widget area, go to Appearance > Customize > Widgets. Alternatively, you
can go to Appearance > Widgets.

The widget can be configured using the settings described below:
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Genesis - User Profile

Title:

Select a user. The email address for this account will be used
to pull the Gravatar image.

Sample User &

eeravatarS\ze: Small (45px)
o Gravatar Alignment:  Left

Select which text you would like to use as the author
description

Author Bio
Custom Text (below)

Fd

ot‘hoose your extended "About Me" page from the list below.
This will be the page linked to at the end of the about me
section.

None
atxtended page link text:
Read More...
e Show Author Archive Link?
Delete | Close m

1. Title: Enter a title for this widget (optional). This title will be displayed at the top of the
widget content.

2. Select a User: Use the drop down to select which registered user will be featured in this
widget.

3. Gravatar Size: Use the drop down to select the size at which the gravatar image should
be displayed. To display this image, the user must have a gravatar from
http://gravatar.com associated with the email address in his or her profile.

4. Gravatar Alignment: Use the drop down to select whether the gravatar image should
be aligned to the left or right of the text.

5. Author Description Text: You can choose to pull the Author's Bio from the user’s
Biographical Info (located in the “About Yourself” section on the user’s profile page in
the dashboard) or you can enter Custom Text to display as the Author Description.

6. Extended "About Me" Page: Use the drop down to choose a page that will be linked to
at the end of the Author Description to provide more information about the Author.

7. Extended Page Link Text: Enter the text you'd like to use to link to the Extended About
Me page.

8. Show Author Archive Link?: Check this box to add a link to the bottom of the widget
content that leads to the author's archive page (a page which includes all the posts
they've authored on the site).

Once you have completed the widget configuration, be sure to click Save at the bottom of the
widget to preserve your settings.
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7.4 Additional Widgets

Some child theme demos may include the use of additional widgets (some can be non-Genesis-
specific) or require the use of plugins that enable additional widgets.

If the child theme you've chosen includes additional widgets in the demo, you can find all the
information you need about how to configure these widgets in the theme setup guide. All child
themes include Theme Setup Guides that can be accessed in the Member's Area at

http://my.studiopress.com/downloads/.

Introduction to Using Your Own Logo or Header Image

Depending upon the options available in the child theme activated on your site, there are two
basic ways of including your own logo or header image on your Genesis site.

If your child theme does not include an option to upload a logo or header image from within the
WordPress Customizer, you will find the Header settings in the Genesis > Theme Settings screen.
If the theme does include the upload option, you'll find a setting in Appearance > Customize >
Header Image.
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8.1 Header Image in the WordPress Customizer

x
You are customizing 9
Sample Site

Active theme

Ch
Atmosphere Pro s

Site Identity

Colors

Header Image

Front Page Image

Background Image

Menus

Widgets

Static Front Page

Breadcrumbs

Comments and Trackbacks

Content Archives

If the child theme activated on your site includes the option to upload a logo or header image via
the WordPress Customizer, you can go to Appearance > Customize > Header Image to add your

image.
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< — D

Customizing

Header Image

While you can crop images to your liking
after clicking Add new image, your theme
recommends a header size off600 = 140
pixels.

Current header

Mo image set

Add new image

Click Add new image to either upload a new image or to select an existing image in the Media
Library. The recommended header size will be displayed on the screen. If you select an image of
any other size, you will be prompted to crop it before it is applied to your site.

Click Save & Publish to preserve your settings.

8.2 Header in the Genesis Theme Settings

WY @A SampleSite B 4+ New Howdy, Sample User [l

Screen Options Help
€ Dashboard Theme Settings Reset Settings
A Posts

Information
0 Media
W Pages Custom Feeds
P Comments
Default Layout
©® Genesis i
Theme Settings Header
SEO Settings
Import/Export
Use for site title/logo: v Dynamic text

Image logo

»¥ Appearance
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If the child theme activated on your site doesn't include an option to upload a logo or header
image from within the WordPress Customizer, go to Genesis > Theme Settings and find the
Header section where you can select to show Dynamic Text for your site title or an Image logo.

The Dynamic text setting will display the site title and tagline that have been set in Appearance >
Customize > Site Identity or in Settings > General in your WordPress dashboard.

If you select the Image logo setting, the dynamic text will be replaced with the logo.png file from
your theme images directory. (Note that in a few themes this may change the header.png file
instead). The text will be hidden using an SEO-friendly text replacement technique.

To change your image logo, you'll need to access your site via FTP and navigate to the child

theme's images directory (example: /wp-content/themes/childtheme/images). Once there, replace
the default logo.png file with your own logo image that you have named logo.png.

Introduction to Using Genesis Templates

@ & samplesite B + New Howdy, Sample User [l

Screen Options Help

&% Dashboard Add New Page

Posts . )
o Enter title here Publish
O3 Media

Save Draft Preview
I Pages

07 Add Medi ¢ Status: Draft Edit
All Pages 2 e Visual | Text

= = - — 4 = <@ Visibility: Public Edit
Add New B I = = £ & — = = =L RE B
[iiil Publish immediately Edit

Move to Trash m

/¥ Appearance Page Attributes

P Comments

© Genesis

& Plugins Parent

o Users

(no parent)

# Tools
Template

Settings

+ Default Template
© Collapse menu Archive [
Blog

Word count: 0 0

Need help? Use the Help tab in the upper

Theme SEQ Settings N
right of your screen.

Document Title [7]

Characters Used: 0 Featured Image

Set featured image
Meta Description [7]

A WordPress page (not a post) can be configured to use a template by selecting an available
template option Page Attributes section in the right sidebar of the page editor screen.
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Some themes may include additional templates. Refer to the child theme setup guide for details
on using additional templates. All child themes include Theme Setup Guides that can be accessed

in the Member's Area at http://my.studiopress.com/downloads/.

9.1 Archive Template

The Archive template creates a sitemap of your site. Go to Pages > Add New to create a page that
will use the Archive template.

\'l:‘ # SampleSite ¥ 4+ New Howdy, Sample User [l

) Screen Options Help
@& Dashboard Add New Page
A Posts : i
: PEnter title here Publish
07 Media

Sawve Draft Preview
[N Pages
Alp B Add Media — T Status: Draft Edit

ages
— — — = - <@ Visibility: Public Edit

Add New B I = = & & — = = £ £ & = =

[iif Publish immediately Edit
¥ Comments e

Move to Trash om
© Genesis
> Appearance Page Attributes
K¢ Plugins parent
% Users
- (no parent) 5
P

Template
Settings

oArchive 5

© Collapse menu

Order

word count: 0 0

Need help? Use the Help tab in the upper

Theme SEQ Settings
right of your screen.

Start by giving the page a title (example: Archive).

In the Page Attributes box on the right side of the screen, use the drop down to select

the Archive template.

3. You will leave the content area blank. The archive template will auto-populate the page
with a sitemap (list of links to posts and pages on your site).

4. Click Publish to preserve your settings.

1.
2

You can add this page to a navigation menu to display a link to your new archive page.
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9.2 Blog Template

The Blog page template displays the latest posts in a blog list format. Go to Pages > Add New to
create a page that will use the Blog template.

\\"l‘ # SampleSite B 4+ New Howdy, Sample User [l

. Screen Options Help
& Dashboard Add New page
Posts . .
+ oEnter title here Publish
07 Media
Save Draft Preview
I Pages
o . 9 Status: Draft Edit
All Pages 1) GEEICS T Visual Text
- _ _ . — e .. @ Visibility: Public Edit
Add New B I #= = = ¢ — = £ = & & = H =
[iiil Publish immediately Edit
P Comments e

® Genesis

> Appearance

K¢ Plugins
o Users
# Tools
Settings

© Collapse menu

Word count: 0

Theme SEO Settings

oot QD

Page Attributes

Parent

-

(no parent)
Template
o Blog B
Order
0

Need help? Use the Help tab in the upper
right of your screen.

Start by giving the page a title (example: Blog).

In the Page Attributes box on the right side of the screen, use the drop down to select

the Blog template.

3. You will leave the content area blank. The blog template will auto-populate the page
with your blog post list.

4. Click Publish to preserve your settings.

N —

You can add this page to a navigation menu to display a link to your new blog page.
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Introduction to Updating the Genesis Framework

The Genesis Framework can be updated in one of two ways. If automatic updates are enabled, you
can update Genesis with just a couple clicks in the WordPress Dashboard. Or if you prefer, you can
update Genesis manually via FTP.

10.1 Updating Genesis Using the Automatic Update

) Screen Options Help
) L Theme Settings Reset Settings
A Posts
Information
07 Media
D 14
¢ Links Version 2.25
[N Pages
A Simple URLs Released: December 17, 2015
P Comments
Updates i
E=) Forms p v Enable Automatic Updates
B wooCommerce If you provide an email address above, you will be notified via email when a new version of Genesis is available.
£’ Products
© Genesis Custom Feeds

Theme Settings

Entar umnir flietamn faad 11D1 -

Automatic updates for the Genesis Framework can be enabled on the Genesis > Theme Settings
screen. Enabling automatic updates allows an update link to appear in your dashboard when a
new version of Genesis is available. The actual update will only happen if you click the link - it is not
automatically started for you.

You can also enter your email address if you'd like to be notified via email when a new version of
Genesis is available.

Howdy, Sample User [l

@ & samplesite &1 P 0

+ New

Screen Options

@ Dashboard

Genesis 2.2.5 is available. Check out what's new or update now.

A Posts

Q] Media Theme SettingS Reset Settings

When a new version of Genesis is available, you'll see a notice at the top of the screen in your
WordPress Dashboard.
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WY @ Sample Site Howdy, Sample User [l

Screen Options Help
Home
hilable. Check out what's new or update now.

Updates 4
A Posts

q:l Media Theme Settings Reset Settings

N Pages

Information version: 2.2.5 - Released: September 9, 2015
P Comments

v/| Enable Automatic Updates

® Genesis
Notify when updates are available

Theme Settings
If you provide an email address above, you will be notified via email when a new version of Genesis is available.
SEO Settings

Import/Export

e oA

If you don't see this notice and you know there's an update available, hover over Dashboard in the
left side menu and click Updates.

\"-." @ SampleSite <1 B 4+ New Howdy, Sample User [l

Help
@ Dashboard WordPress Updates

Home

Last checked on January 1, 2016 at 7:31 am.] Check Again

Updates (1

You have the latest version of WordPress.

Posts . . ;
~ If you need to re-install version 4.4, you can do so here or download the package and re-install manually:

07 Media

Re-install Now Download 4.4

N Pages

If you still don't see the available update, click Check Again to trigger the update notice.

Genesis 2.2.5 is available. Check out what's new or update now.

To begin the update process, click the update now link in the update notification at the top of
your dashboard page.
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@A SampleSite <0 B 0 <4 New Howdy, Sample User .

@ Dashboard
Genesis 2.2.5 is available. Check out what's new or update now.

A Posts
0] Media Update Theme

N Pages Downloading update from http://www.genesistheme. com/download/?file=genesis.2.2.5.zip..

¥ Comments Unpacking the update...

Installing the latest version...

® Genesis
Removing the old version of the theme...
}‘ Appearance Theme updated successfully.

Themes Click here to complete the upgrade

On the next screen, click the Click here to complete the upgrade link. It's very important to click
this link before moving on to other areas of your dashboard.

After the new version is installed, you will be redirected to the Genesis > Theme Settings screen.
All done!

IMPORTANT NOTE: As a precaution, make sure you have backup copies of your child theme
and your current version of Genesis before updating Genesis.

Also, if you have made any changes directly to files in the /genesis/ directory (or folder),
updating will overwrite these changes. We strongly recommend that you never make
changes this way.

Additionally, when updating Genesis on a multi-site installation of WordPress, visit the

Genesis > Theme Settings screen of each site to ensure that any necessary database updates
are completed.

10.2 Updating Genesis Manually

Follow these steps to update Genesis manually:
1. Log into your My StudioPress account and download the latest version of Genesis from

http://my.studiopress.com/downloads/
2. Extract the zip file to your computer and note it's location.
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3. Upload the new, unzipped genesis folder to your /wp-content/themes directory (or
folder) from your computer to your web server via FTP. Overwrite the old version with
the new one.

IMPORTANT NOTE: As a precaution, make sure you have backup copies of your child theme
and your current version of Genesis before updating Genesis.

Also, if you have made any changes directly to files in the /genesis/ directory (or folder),
updating will overwrite these changes. We strongly recommend that you never make
changes this way.

11.1 Plugins

One great thing about Genesis is that it's been designed to be extended to almost any need you
might have through the use of plugins.

\‘:‘ # SampleSite B + New Howdy, Sample User [l

) Help
& Dashboard Add Plugins upload Plugin
A Posts
Search Results ~ Featured  Popular  Recommended  Favorites Keyword % genesis simple edits
87 Media
N Pages 48 items 1 of2| »
P Comments
Genesis Simple Edits Genesis Simple Install New
© Genesis This plugin lets you edit the three most More Details Customizations More Details
commanly modified areas in any Genesis Easily make certain customizations to
¥ Appearance theme: the past-info (byline), the post- your Genesis-powered site in the Genesis
p—— meta, and the footer area. Theme Settings menu. You must be using
A Plugins the Genesis theme framework.

Installed Plugins
Add New
Editor

(24)

By Nathan Rice

Last Updated: 3 months ago

By Doug Yuen

100,000+ Active Installs Untested with your version of WordPress 4) Last Updated: 5 months ago
* Users 2,000+ Active Installs Untested with your version of WordPress
# Tools
Settings Genesis Simple Hooks Genesis Simple Sidebars

© Collapse menu

(18)
80,000+ Active Installs

This plugin creates a new Genesis
settings page that allows you to insert
code (HTML, Shortcedes, and PHP), and
attach it to any of the 50+ action hoo

More Details

By Nathan Rice

Last Updated: 3 months ago

Untested with your version of WordPress
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(18)
50,000+ Active Installs

This plugin allows you to create multiple,
dynamic widget areas, and assign those
widget areas to sidebar locations within
the Genesis Framework on a

More Details

By Nathan Rice

Last Updated: 3 months ago

Untested with your version of WordPress

Page 77



Go to Plugins > Add New to search for and install plugins through your WordPress Dashboard.
Use the Search feature to search for a plugin by title.

Genesis Simple Edits

This plugin lets you edit the three most More Details
commonly modified areas in any Genesis

theme: the post-info (byline}, the post-

meta, and the footer area.

By Nathan Rice

(24) Last Updated: 3 months ago

100,000+ Active Installs Untested with your version of WordPress

When you locate a plugin you'd like to use, click the Install Now button and follow the on-screen
instructions to install the plugin.

StudioPress Genesis Plugins

Here's a set of very user-friendly plugins we've developed to help you customize your site. Below is
brief description of what each one can do for your site.

AgentPress Listings

The AgentPress Listings plugin uses custom post types, custom taxonomies, and widgets to create
a listings management system for AgentPress. You can use the taxonomy creation tool to create
your own way of categorizing listings, and use those taxonomies to allow users to search for
listings.

Genesis Author Pro

The Genesis Author Pro plugin uses custom post types and widget to add a book library to any
Genesis child theme to attractively display book details in single and archive views.

Genesis Beta Tester

This plugin hooks into the data sent to the Genesis API servers and lets us know that you'd like to
update to the latest version of Genesis, even if it's still in beta.
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Genesis Responsive Slider

This plugin allows you to create a simple responsive slider that displays the featured image, along
with the title and excerpt from each post.

Genesis Simple Edits

This plugin creates a new Genesis settings page that allows you to modify the post-info (byline),
post-meta, and footer area on any Genesis theme. Using text, shortcodes, and HTML in the
textboxes provided in the admin screen, these three commonly modified areas are easily editable,
without having to learn PHP or write functions, filters, or hooks.

Genesis Simple Hooks

This plugin creates a new Genesis settings page that allows you to insert code and attach it to any
of the action hooks throughout the Genesis Framework. Instead of the sometimes tedious and
unfamiliar process of creating functions in your theme files, this plugin gives you an attractive,
easy-to-use interface for modifying your Genesis theme via the hook system.

Genesis Simple Menus

The Simple Menus plugin allows you to assign WordPress navigation menus to the secondary
navigation menu within the Genesis Framework on a per post, per page, or per tag/category
archive basis.

Genesis Simple Share

The Genesis Simple Share plugin allows you to easily add beautiful share buttons to your site using
a Genesis child theme.

Genesis Simple Sidebars

This plugin allows you to create multiple, dynamic widget areas, and assign those widget areas to
sidebar locations within the Genesis Framework on a per post, per page, or per tag/category
archive basis. Creating widget areas programmatically, then using conditional logic to properly
assign them to sidebar locations can be a complex task for a beginner.

Genesis Slider

This plugin includes options for auto-progress and the dimensions of your slideshow. It also allows
you to choose to display posts or pages, what category to pull from, and even the specific post IDs
of the posts you want to display. Finally, you can place the slider into a widget area.

www.studiopress.com - 3/6/2017 v.3.0 Page 79


http://wordpress.org/extend/plugins/genesis-responsive-slider
http://wordpress.org/extend/plugins/genesis-simple-edits
http://wordpress.org/extend/plugins/genesis-simple-hooks
http://wordpress.org/extend/plugins/genesis-simple-menus
http://wordpress.org/plugins/genesis-simple-share/
http://wordpress.org/extend/plugins/genesis-simple-sidebars
http://wordpress.org/extend/plugins/genesis-slider

Genesis Tabs

This plugin allows you to create a tabbed section, via a widget, that can display the featured image,
along with the title and excerpt from each post. Choose which categories you want to feature in
the tabbed section, which post elements you want to show, and save the widget. Place the widget
in the feature section of a Genesis child theme.

SEO Data Transporter

This plugin allows you to transfer the SEO data (such as title tags and meta descriptions) you've
entered in one WordPress theme/plugin to another. We all know how difficult it can be to switch
themes or dump plugins, and the fact that themes and plugins store their inputted SEO data
differently makes it even harder. This plugin remedies that.

Simple Social Icons

This plugin is an easy to use, customizable way to display icons that link visitors to your various
social profiles. With it, you can easily choose which profiles to link to, customize the color and size
of your icons, as well as align them to the left or right, all from the widget form (no settings page
necessary!).

Simple URLs

This plugin is a URL management system that allows you create, manage, and track outbound links
from your site by using custom post types and 301 redirects.

Social Circles

A simple widget that allows you to place links to your social media accounts. Instead of icons, each
link is a circle using text (in various fonts) to indicate the site being linked to.

Social Profiles Widget

This plugin allows you to insert icon links to your social profiles in any widget area. By simply
dragging this widget into your sidebar or any widgetized area, you can easily place icon links to
your various social profiles such as Feedburner, Twitter, Facebook, Linkedin, YouTube, Flickr,
Delicious, StumbleUpon, Digg and Myspace.

Third Party Genesis Plugins

In addition to the plugins we've developed here at StudioPress, there are many Genesis-specific
plugins available that have been developed by others in the Genesis community.
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*Please note that these third party plugins are not supported or maintained by StudioPress.
Genesis eNews Extended

This plugin creates a new widget that allows you to easily add mailing list integration to a Genesis
website. It works with FeedBurner, MailChimp, AWeber, FeedBlitz and more.

Genesis Design Palette Pro

This plugin allows you to quickly and easily modify the look of each area of your site without
touching any code.

Genesis Connect for WooCommerce

This plugin allows you to seamlessly integrate WooCommerce with the Genesis Framework and
Genesis child themes.

And so many more...

There are so many more Genesis plugins for you to try out. Just do a search for “Genesis” in the
WordPress plugins repository and you will get 200+ results (as of this publication).

11.2 Helpful Links

Whether you are just getting started or want to learn more, you will find these resources helpful.
WordPress Resources

« About WordPress

« WordPress Docs (The Codex)

« Getting Started with WordPress

« New To WordPress - Where to Start
* WordPress Lessons

« Learn WordPress

« WordPress.tv

« WordPress FAQ

 Finding WordPress Help
* WordPress 101

Genesis Resources
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+ StudioPress Tutorials - StudioPress site with tutorials for using and customizing Genesis.

+ Genesis Tutorials - This is a third party resource that is not affiliated with StudioPress. There
are a number of useful tutorials on the site.

+ Genesis Explained - If you are looking for more instruction on the nuts and bolts of Genesis,
then this developer's guide tutorial series is a great place to start.

+ Genesis Plugins - The official Genesis plugins page

« Community Forums - The community forums is the place for discussing projects with other
users, finding a developer to assist you, and brainstorming code with the community.
Anyone can register here.

Additional Resources for Installation & Getting Started

+ Building Child Themes - StudioPress site with tutorials for customizing the Genesis Sample
Child Theme.

+ Importing Demo Content - StudioPress tutorial that shows you how to import the theme
demo content.

12.1 Common Installation Error Messages

Genesis Not Found

The Problem: This message is triggered by activating the child theme without Genesis being
installed, or accidentally deleting Genesis (sometimes for a manual upgrade) with the child theme
already active. Either of these actions will result in an error like this:

Warning: require_once(%path-to-wordpress%/wpcontent/themes/genesis/lib/init.php)
[function.require-once]: failed to open stream: No such file or directory in %path-to-
wordpress%/wp-content/themes/%childtheme%/functions.php on line 3

The Solution: You will need to access your site via FTP. Once there, navigate to your site’s theme
directory (or folder). This will vary by host and site setup, but it is usually /public_html/wp-
content/themes/. The error code will actually tell you exactly where this is. Typically you will not
have access to the first part of the path, but you will have access starting around the public_html
(or similar) directory (or folder).

If you already have Genesis backed up on your computer, find that directory (or folder). Otherwise,
you will need to download the latest version of Genesis from my.studiopress.com and unzip it to a
location on your computer. Make a note of where the file is and navigate to it in your FTP client.

Make sure the folder you are about to upload is “genesis” (spelled exactly like that) and that
directly inside that folder is “style.css” (along with several other files and folders).
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Use Filezilla or your preferred FTP program to upload the "genesis" folder.
WordPress Needs Upgrade

The Problem: When a function doesn't exist, it is often caused by WordPress being out of date.
Always upgrade to the latest version of WordPress. Of course, the simple upgrade isn't available if
this error happens. The error might look something like this:

Fatal error: Call to undefined function add_theme_support() in /%path-to-wordpress %/wp-
content/themes/genesis/lib/init.php on line 17

Another error you may see when WordPress isn't updated to the latest version may look like:

Warning: Invalid argument supplied for foreach() in /home/user/wp-content/themes/genesis/lib/
admin/term-meta.php on line 256

The Solution: You will need to upgrade WordPress. Of course this can’t be done since you can't get
to your dashboard. To get to your dashboard you will need to access your site via FTP and navigate
to the theme directory (or folder). This is usually /wp-content/themes/. Then you need to either
remove the active theme, or just move it out of the theme directory (or folder). This disables the
theme and enables the default theme.

Once the default theme is enabled you can login, update WordPress, and put your theme back or
reinstall it (depending on if you moved or deleted the theme), then reactivate the theme.

If you are using the latest version of WordPress, we recommend making sure your database was
also upgraded. Visit http://yourdomain.com/wp-admin/upgrade.php, replaying "yourdomain.com"
with your site's domain name. If a database update is required, you may do so from this page.

PLEASE NOTE: We recommend keeping WordPress and Genesis updated on your site. If both
need to be updated at the same time, update WordPress first and Genesis second.

Questions?

We hope this guide has been helpful as you get started using the Genesis Framework for
WordPress!
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If you have any questions, you can log into the Member's Area at http://my.studiopress.com/ and
file a ticket with our support team.

We're always here to help!
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